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RESUME :   
 
The purpose of COLEGRAM is the processing of complex experimental spectra to 
describe individual features and to derive individual area for each peak or shape of 
interest. The individual components are modeled using a mathematical function 
adapted to the spectrum nature. The fitting of the mathematical function to 
experimental data is achieved using the chi-squares method with the Marquardt-
Levenberg algorithm. 
 
The different capabilities of the sofware are presented. 
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1. Introduction 
 

The COLEGRAM software suite was originally designed for use in gamma-ray and X-ray 
spectrometry. The purpose of COLEGRAM was to accurately process experimental spectra to 
separate overlapping components and derive individual areas for each of them, especially in 
the 100 keV photon energy region including both X- and gamma-ray peaks [1,2]. Since this 
starting point, COLEGRAM has been upgraded and is now available with more options for 
processing different types of spectra. This is achieved by fitting mathematical functions to 
experimental data sets. Several types of functions can be used, depending on the kind of 
spectrum; most of them are specific to a particular peak shape: alpha, gamma, X, or beta. 
Functions for overall background shapes, such as exponential or polynomial, are also 
available. COLEGRAM uses the least squares fitting method with the Marquardt-Levenberg 
algorithm and is based on a visual management under the user control. 

 
Thus, this approach makes the code fast running and induces an important visualization 
interface what makes it easy, at any time, to modify the spectrum region under study, to check 
the fitting procedure, to add or to delete any peak, to change its shape etc. 

 
The present version of COLEGRAM requires a personal computer running Windows®. The 
code in written in Microsoft Visual C++ and is currently compiled with Version 6 of this 
language. 

 

2. Principle of the fitting method 
 

The purpose of COLEGRAM is to process complex spectra comprising several components, 
to describe overlapping features and to derive the area of each peak or shape of interest. The 
individual components are therefore modeled using mathematical functions, according to the 
user’s theoretical knowledge of the spectrum constitution.  
 
Fitting a mathematical function to n experimental data (xi, yi) consists in determining the 
optimum set of m parameters (a = a0, a1, ..., am), such that the computed values with function 
f(xi; a) will be as close as possible to the experimental values yi. The different parameters of 
the fitting function are obtained by the non-linear least-squares method [3]. 

 
Generally, if Φ is the function to minimize: 
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where σi represents the standard deviation of experimental value yi. 

 
The parameters values are obtained by minimization of Φ, i.e. by canceling out the values of 
its partial derivatives:  
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This minimization is performed using the Marquardt-Levenberg algorithm (Appendix 1) 
which uses two different approaches as fitting progresses: far from the minimum, the gradient 
method is first used, then, when near the minimum, it is replaced by the Hessian method. In 
both cases, solving the equation system requires computation of the first derivative for each of 
the m parameters. Uncertainties (variances) associated to each parameter are calculated during 
the fitting procedures, as well as covariances of the different parameters. 

 
Two options are proposed for conducting the fitting. The first option corresponds to a simple 
minimization, without taking account of individual weighting of the experimental data (σi = 
1): this is the “least squares” option. The second option uses the “chi-2” criterion, i.e. 
including the standard deviation of each experimental point (σi

2 = yi).  
 

3. Software presentation 

3.1 General characteristics 
 

COLEGRAM runs under Windows®. It can handle spectra from different origins. In the 
present version, spectra obtained by acquisition software such as Intergamma® (extension 
.spe), ACC (extension .dat), Maestro® (extension .chn or .spc) are directly identified by the 
file extension. ASCII files (extension .asc) can also be directly read: they must include two 
columns, the first with the channel number (or the energy) and the second containing the 
count number for the relevant channel. The entire spectrum loaded, including its energy 
calibration, is displayed in the main window (§3.1.1). Information useful for the user is 
presented in screens as described below. COLEGRAM generates its own spectrum file 
(extension .spm) including all the parameters obtained in the fitting procedure (§3.2.5). 

 

3.1.1 Main window  
 

All the windows used to display the data being processed (spectra or region of interest (ROI)) 
and fitting results are included in the main window shown in Figure 1. The menu bar is under 
the title bar: it changes according to the processing step. In the first screen, it includes three 
tabs:  

- “File”: used for file opening (see §3.2.1), and printing and saving results (see §3.2.5), 
- “View”: to display or mask the window elements, 
- “Help”: to provide help by indexed words and display the version number of the 
software. 
 

Two other bars are also available: the upper one includes a set of buttons corresponding to 
menu item shortcuts; the second one, on the window bottom, displays information with a short 
help text about the item selected. 
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Figure 1 - COLEGRAM main window 

 

3.1.2 Floating windows 
 

The main window contains three floating windows allowing the user to control the application 
progress (Figure 1): 

 
- the “Palette” window (upper right-hand side), which comprises a set of buttons 

corresponding to commands affecting spectra or ROIs: selection and modification of an ROI, 
opening of secondary window, processing of an ROI, peak fitting, zoom, spectrum display 
mode etc., 

 
- the “Cursor information” window, which appears underneath and shows information 

on the data (spectrum or ROI) being processed and the cursor position (channel number or 
energy - if the spectrum file includes the energy calibration - and content of the relevant 
channel), 

 
- the “Peak information” window, which appears below the main window and is a 

dialog box displaying parameters of the peaks of any ROIs be processed. 
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3.2 COLEGRAM practical use 

3.2.1 Opening a file 
 

The user has several ways of opening a spectrum file:  
- select “open” (shortcut: “Ctrl” + “O”) from the “File” menu or use the equivalent 

button in the bar under the menu bar, 
- click twice on the document (extension .spm) in Windows® Explorer, 
- slide the document from the Windows® Explorer to the application window. 
 

As soon as a document is open, the entire relevant spectrum is displayed in a secondary 
window (Figure 2). The menu bar includes two new tabs marked “Display” and “Window”. 
The “Window” menu can be used to hide or show either floating window. With the “Display” 
menu, or with the “Palette” window tools, it is then possible to change the display mode 
(shape and color) of the experimental points, to zoom in and out, to slide the spectrum or to 
change the vertical scale (linear, logarithmic or root square) to better examine a region of 
interest.  

 
 

 
Figure 2 - Spectrum displayed in the secondary window (103Pd). 
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3.2.2 Selecting a region of interest  
 

The user can then select regions of interest with the first two upper left buttons (set and clear) 
of the “Palette” window and use the mouse to mark the selection. Experimental points of 
selected ROIs are shown in a different color and each ROI can hence be displayed it in its 
own window by clicking on the upper right button (Figure 3). 

 

 
Figure 3 - Selection of a region of interest 

 

3.2.3 Processing of a region of interest  
 

The same display adjustments as for the whole spectrum are available for the region of 
interest (“Palette” tools). The button for subtracting the background from the selected ROI 
(left button on the second row) is a tool mainly used in gamma-ray spectrometry (Appendix 
2). The user must then define the peaks included in each ROI. The default peak shape is 
selected either using the “Peak class preference” available in the “File” menu, or clicking on 
the middle button of second row in the “Palette” window. By default, the same shape is 
applied to each peak of the ROI.  
 
A peak is input by setting the cursor at a defined position and clicking on the mouse left 
button. The defined peak is drawn as a continuous line in the graph of the experimental data 
(Figure 4). 
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Default parameters characterizing the peak shape are thus displayed in the “Peak information” 
window. Using this dialog box, the user can successively display parameters linked to each 
defined peak by clicking on one of the double arrows buttons (back or forward). For each one, 
he can change the peak shape, modify any parameter and fix or free it. Spurious peaks can 
also be deleted from this box. Any change must be validated by clicking on the “Set” button 

or on double arrows buttons on the last row of this window: using these last ones, at the same 
time, the parameters are validated and the cursor moves to the next (or previous) peak 
position. 

 
 

Figure 4 - Initialization of the peaks of the selected ROI 
 

3.2.4 Mathematical function fitting 
 

At any stage of the processing, the user can run the fitting tool which searchs the best fit of  a 
mathematical model to the experimental spectrum, thus improving the parameters. Two fitting 
methods are available: the “least squares” and the “chi-2” methods (§ 2). These methods are 
iterative and the user can run iterations either one by one or in series of ten. After each fitting, 
display is updated and the user can act upon the value of the different parameters (Figure 5). 
Both criteria (least squares and chi-2) are quoted below the cursor information, in the “Cursor 
information” window; this allows the user to judge the quality of the fit.  
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Figure 5 - Fitting peaks in selected ROI 
 
 

There is another means of visual and quantitative control of the fitting results that is to display 
residuals in a different window (Figure 6). Two methods are available for computing 
residuals: 
 

- the relative residuals are expressed as a percentage and computed as: 
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The choice of the residuals computation mode is selected from the main window (command 
“Residuals preference” in the “File” menu). 

 
 

 
 

 
Figure 6 - Display of the fitting residuals  

 

3.2.5 Saving results 
 

At any time, the user can save the spectrum (item “Save as” on the “File” menu), including its 
ROI and the associated peaks, in a file with an “spm” extension: the file format is specific to 
COLEGRAM. Saves can be used as parameter starting points for processing similar spectra.  

 
The user can also produce files including a list of all peaks of an ROI with their parameters 
and the associated areas, as well as uncertainties resulting from the fitting procedure (item 
“Save all ROIs” on the “File” menu). Peak areas are computed as theoretical values from the 
parameter values. Uncertainties are obtained by quadratic combination of variances and 
covariances of the parameters concerned. Result files are produced either in pure text format, 
or in format that can be imported by EXCEL® (“Save all ROIs EXCEL”). Appendix 3 gives, 
for each fitting function, a list of parameters as given in these result files, and the formula 
used for computing the associated area. 

 
Last, it is possible to print (or to send to an external file in Windows® metafile format) a 
picture of the spectrum with its ROIs, or the ROI with its peak and the fitting function. 
Printing options are available on the “File” menu. 
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4. Functions used for the fitting process 
 

In each region of interest, n individual peaks are defined, each one being characterized by its 
own shape and parameters such as position, amplitude, etc.. Depending on the nature of the 
spectrum under study, the user can choose between 25 different peak or background shapes. A 
peak is described by up to 9 parameters depending on the option selected. Each parameter is 
fixed or free, at the user’s choice (§3.2.3); this can be changed at any stage in the fitting 
procedure. 

 

4.1 Basic peak shapes 
 

These shapes are traditionally associated with common kinds of spectra, gamma, alpha or X, 
and are based on a Gaussian function. 

 

4.1.1 Gaussian: G(x) 
 

Gamma-ray peaks can be simply fitted using a Gaussian profile: 
 

G(x) = A
σ π2

× exp [ 
− −( )x x0

2

22σ
 ] 

 
The peak is entirely characterized by three parameters: position x0, amplitude A, and standard 
deviation σ. Initial values for position and amplitude are taken from the experimental values 
at the cursor position; the standard deviation is evaluated from the peak full width at half 
maximum. 

 

4.1.2 Tailed Gaussian: TG(x) 
 

A left-hand tail can be added to the basic Gaussian. In gamma-ray spectrometry, this shape 
can be used to take into account events due to incomplete charge collection in the detector. 
The tail is modeled as an exponential function truncated at the peak position, convolved with 
a Gaussian representing instrumental broadening: 
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what can also be expressed in a simpler way for computing: 
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This shape includes two more parameters: tail relative amplitude T, and exponential slope τ. 
By default, the initial values are 0.1 and σ respectively. 
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Then: 

TG(x) = G(x) + T(x) 
 

erfc is the complementary error function: 
 

∫
∞ −
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It is computed using an approximation [3] giving fractional error less than 1.2×10-7. 

 

4.1.3 Gaussian with two tails: DTG(x) 
 

This function includes a tail on each side of the Gaussian: the high energy tail can be use to 
take into account event due to pile-up effects in the case of gamma-ray spectra recorded with 
a high count rate. 

DTG(x) = G(x) + LT(x) + RT(x) 
 
The left-hand tail function, LT(x) is the same as the tail function described above, with 
parameters T1 and τ1; the right-hand tail function, RT(x) is expressed as:  
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with right-hand tail relative amplitude T2 and slope of the decreasing exponential τ2. By 
default, their initial values are 0.1 and σ respectively. 
 
erf is the error function:  

∫ ⋅−⋅
π

=
x

0

2 dt)texp(2)x(erf  

 

4.1.4 Alpha: ALPHA(x) 
 

This function in use in alpha spectrometry has been proposed by Bortels et al. [4]. It is another 
extension of the tailed Gaussian function, as it is sum of a Gaussian and of two left-sided tails:  

 
ALPHA (x) = G(x) + T1(x) + T2(x) 

 
Two additional parameters are required to entirely characterize this shape: T2, the relative 

amplitude of the second left-side exponential and τ2, its slope. These are initialized at 0.1 and 
σ/2 respectively. 
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4.1.5 Voigt and Voigt'plus': V(x) 
 

The Voigt function is adapted to the shape of X-ray peaks as it is the result of convolving a 
Lorentzian function (corresponding to the natural shape of X-ray line) with a Gaussian profile 
taking account of the instrumental broadening: 

 

∫
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To entirely describe the Voigt function, it is necessary to include the Lorentzian width Γ in the 
parameters used for the Gaussian shape; by default, its initial value is σ/5. 

 
The Voigt function is computed using approximations (see Appendix 4); in some cases (σ 
large compared to Γ), the simpler Voigt approximation fails and the more detailed “Voigt 
plus” approximation can then be used, but the computing time is longer.  

 

 

4.1.6 Tailed Voigt: TV(x) 
 

This function is similar to the tailed Gauss, with a Voigt function instead of the Gaussian:  
 

TV(x) = V(x) + T(x) 
 

This function is entirely defined using 6 parameters, as the parameters of the “Voigt” 
functions must be completed by the left-side tail parameters, T1 and τ1 (relative amplitude and 
slope) (§4.1.2).  

 

 

4.1.7 Voigt with two tails: DTV(x) 
 

Here, the Voigt shape is completed by a tail on each side:  
 

DTV(x) = V(x) + LT(x) + RT(x) 
 
As for the Gaussian with two tails (§ 4.1.3), the parameters of the “Tailed Voigt” functions 
must be completed by the right-side tail parameters T2 and τ2 (relative amplitude and slope). 
This function is thus entirely defined using 8 parameters. 
 

4.2 Beta functions 
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These functions are dedicated to beta spectra processing: they include three options according 
to the transition type (allowed or forbidden). The function is described in [5]; it is a product of 
three factors: 

 
BETA (E) = STAT(E) . COULOM(E) . FORME(E)  

 
The statistical factor is:  

STAT (E) = E2 1−  . E (E0 - E)2 
 

E is the electron total energy, expressed in m0c2 units, and E0 is the beta transition maximum 
energy. The electron momentum, p, is E2 1− . 

 
The Coulomb factor is the product of the Fermi function, F(E), and the function L(E):  
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and: 
L (E) = 1 + [ 1 - (α Z)2 ]1/2 
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In these functions, Z is the atomic number of the nuclide daughter, and sgn, the sign of the 
emitted charge, α is the fine structure constant (1/137.036), and Γ is the complex or real 
gamma function. 

 
R’ = R/h,  R is the radius for which the electron wave function is evaluated:  
R’ = 0.002908 A1/3 – 0.002437 / A1/3,  A is the mass number of the daughter nuclide. 

 
 

If the electron screening effect is taken into account, the Fermi function becomes:  
 

F’(Z, E’) = F(± Z ,E + V0) 
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where V0 is the Fermi-Thomas potential: V0= 1.45 α2 Z4/3. 
 
The form factor depends on the transition type: 
 
 - Allowed transition: 
 
  FORME1(E) = 1  
 
or, to take into account an experimental shape factor: 
 



 

 16

FORME1(E) = 1 + aE + b/E + cE2  

 
 - First forbidden non unique transition: 
 

FORME2(E) = 1 + aE + b/E + cE2 + d(q2 + λ1p2) 
 
 - First forbidden unique transition: 
 

FORME3(E) = q2 + λ1p2 
 
 - Second forbidden non unique transition: 
 

FORME4(E) = q2 + B λ1p2 

 
 - Second forbidden unique transition: 
 

FORME5(E) = q4 + 10/3 λ1 q2p2 + λ2 p4 

 
 - Third forbidden non unique transition: 
 

FORME6(E) = q4 + A λ1 q2p2 + B λ2 p4 

 
 - Third forbidden unique transition: 
 

FORME7(E) = q6 + 7 λ1 q4p2 +7 λ2 q2p4 + λ3 p6 
 
q is the neutrino momentum. 
 
These functions respectively correspond to seven options proposed in the software: Perm, 
1INU, 1IU, 2INU, 2IU, 3INU et 3IU. 

 
 

Parameters of beta functions are:  
 

 - maximum energy, E0, and amplitude; initial values are taken from the cursor position 
and the relevant channel content; 
 
 - atomic number, Z, mass number, A, and sign of the emitted charge: these three 
parameters depend on the considered radionuclide and are fixed; their default values are: 1, 3 
and -1, respectively; 
 
 - shape parameters, according to the transition nature: a, b, c for the allowed transition, 
and for the forbidden ones: d, λ2, λ3 et  λ4. Each of them are initially set to 0. 

 

 

 

4.3 Functions conditional upon standard deviation  
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Options have been included to take into account the variation of the instrumental width versus 
the energy. Then, the standard deviations of several peaks in the same ROIs can be linked as: 
 

xk2
0

2 ⋅+σ=σ  
 

x is the energy position, σ0 is the width offset and k is the slope of the function; these 
Gaussian width parameters are common to all peaks characterized by the same “sigma” shape. 

 

4.3.1 Gaussian (sigma): GS(x) 
 

With this function, the Gaussian widths are linked according to the above relation, and then:  
 

GS(x) = G(x, σ(x)) 
 
To describe each peak, four parameters are necessary: two parameters (amplitude and 
position) are characteristic of the individual peak, and two parameters are common to all 
linked peaks (σ0 and k). By default, initial values of these are respectively 0.1 et 0.01.  

 

4.3.2 Voigt (sigma): VS(x)  
 

As for the Gaussian peak, here, the instrumental width broadens with the energy: 
 

VS (x) = V(x, σ(x)) 
 

Each peak then includes three individual parameters (A, x0 et Γ) and two common parameters 
for the Gaussian standard deviation (σ0 and k), as above-described.  

 

 4.3.3 Alpha (sigma): AS(x) 
 

In these case, there is no variation of the Gaussian standard deviation but the same constant 
width is affected to all peaks of the ROI. The tails parameters (relative amplitudes and slopes) 
are also parameters common to all these peaks. Description of this function thus requires 2 
individual parameters for each peak (position and amplitude) and five parameters (standard 
deviation, relative amplitudes and slopes of the two tails), common to all peaks with the same 
shape. 

 

4.4 Background functions  
 

Four functions have been added to fit regions with smooth variations such as background, or 
discontinuities, such as Compton edge in gamma-ray spectrometry. They are defined only for 
channels included in the ROI (or just in part of the ROI for the last two functions), thus the 
quoted surface corresponds only to the relevant region. 

 

4.4.1 Background with one step: STEP(x) 
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This function describes a step shape superimposed on a constant background: the 
discontinuity is the convolution of a step function, constant for x ≤ x0 and null for x > x0, 
convolved with a Gaussian function representing the signal experimental broadening: 
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Parameters useful to define the STEP function are: step position x0 and amplitude S, Gaussian 
standard deviation σ and constant background amplitude B. 
 
Initial values of the background amplitude correspond to the channel content of the first 
channel of the ROI; the initial position of the step is taken at the cursor position, and the 
initial step amplitude is the difference between contents of first and last channels of the ROI.  

 

4.4.2 Background with two steps: DSTEP(x) 
 

This function is the same as above but there are two steps to fit two successive discontinuities 
or a bump superimposed on a constant background: 
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That is: 

( ) ( )
2
xxerfcS

2
xxerfSB)x(DSTEP 2

2
1

1
σ
−

⋅+
σ
−

⋅+=  

 
The parameters are defined as for the STEP function, indexes 1 and 2 referring respectively to 
the first and the second step. 
 
Initial values of the background amplitude correspond to the channel content of first channel 
of the ROI. The initial position of the first step is taken at the cursor position, and its initial 
amplitude is half of difference between the contents of the first and last channels of the ROI. 
The initial position of the second step is taken between the cursor position and the last channel 
of the ROI, and its initial amplitude is the same as the first step one. 

 
 

4.4.3 Exponential background: EXPO(x) 
 

This function is a simple exponential that can be defined for only part of the ROI:  
 

( )[ ]τ−⋅= 0xxexpA)x(EXPO  
 

 
 
The function parameters are the exponential amplitude and slope, A and τ, and the starting 
and ending positions of the function, x0 and E. By default these one are initialized with the 
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first and last channels of the ROI and fixed; the initial amplitude is the channel content of the 
first channel and initial slope is computed from channel contents of the ROI limits.  

 

4.4.4 Polynomial background: POLY(x) 
 

As in the previous case, this polynomial function of fourth order can be specified for only a 
part of the ROI:  

 
( ) ( ) ( ) ( )4

04
3

03
2

02010 xxAxxAxxAxxAA)x(POLY −+−+−+−+=  
 
Initial values of the function parameters x0, E (end position of the defined function), A0 and 
A1 are respectively the first and last channel of the ROI, the channel content of the first 
channel, and the slope between channel contents of the ROI limits; x0 and E are initially fixed. 
A2, A3, A4, are initialized at zero and fixed. 
 
 

4.5 More specialized functions  

4.5.1 Hypermet: HYPER(x) 
 

This fitting function was first introduced by Philips and Marlow [6]. It can be used for fitting 
gamma or X-ray peaks. It is the sum of a Gaussian, a low-energy tail and a discontinuity 
centered on the peak position: 

 
HYPER (x) = G(x) + T(x) + S(x) = TG(x) + S(x) 

 
The tail, T(x), is modeled by an exponential function truncated at the peak position, convolved 
with a Gaussian representing the instrumental broadening.  

 
 

The discontinuity, S(x), results from the convolution of a step function, with a constant value 
for x ≤ x0 and zero value for x > x0, by the Gaussian instrumental broadening. 

 
( )

]
2
xxerf1[SA'dx
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x'xexpSA)x(S 0

x
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This function is entirely characterized by 6 parameters; the fist five are the same as those of 
the Tailed Gaussian (§4.1.2), and the last one is the step function relative amplitude, S with an 
initial value of 0.01.  
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4.5.2 Hypermet Voigt: HYPERV(x) 
 

This function is the adaptation of the above-mentioned HYPER function to X-ray peaks, 
replacing the Gaussian main peak by a Voigt function: 

 
HYPERV (x) = V(x) + T(x) + S(x) = TV(x) + S(x) 

 
It is described by 7 parameters: 6 correspond to the description of the tailed Voigt function 
(§4.1.6) and the last one is the step function relative amplitude, S with an initial value of 0.01.  

 
 

4.5.3 Low Energy X Gauss: LOWE(x)  
 

This function was introduced to handle the case of X-ray peaks in the vicinity of silicon K 
binding energy of silicon. This extension of the Hypermet function has been proposed by 
Scholze and Ulm [7]: it includes another discontinuity that is a double-step convolved with 
the basic Gaussian: 

 
LOWE (x) = G(x) + T(x) + S(x) + ST(x) = HYPER(x) + ST(x) 

 
with: 
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The supplementary parameters, ST (relative amplitude of the double step) and k (low-energy 
bound of the function) are initialized at 0.005 and 0.1 respectively.  

 
 

4.5.3 Low Energy X Voigt: LOWEV(x) 
 

This function is the adaptation of the above LOWE function to X-ray peaks, to take the 
natural width of the lines into account, thus replacing the Gaussian main peak by a Voigt 
function: 
 

LOWEV (x) = V(x) + T(x) + S(x) + ST(x) = HYPERV(x) + ST(x) 
 

This last function is the most complex one, as its definition requires 9 parameters: the seven 
first ones are the same as for the HYPERV function, and the last two ones, for ST, are defined 
and initialized as for the above-mentioned LOWE function. 
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5. Conclusion 
 
 

The COLEGRAM software in use in LNHB since 1996 has enabled significant improvement 
in the processing of gamma- and X-ray spectra [2, 8-10]. In our laboratory, it has also been 
applied in alpha-particle spectrometry [11].  
 
Now, this user-friendly tool can also be applied to other kinds of spectra. However, its right 
operation requires competence of an experienced user. Actually, the different fitting functions 
must be chosen according to the kind of spectra to be processed; moreover, some physical 
parameters can be efficiently imposed and fixed, for example, with the knowledge of the 
radionuclide decay scheme and acquisition conditions.  
 
For efficient fitting and reliable results, the user must always keep in mind the physical 
meaning of the modeling and not only increase the number of adaptable parameters to make 
the fitting easier. Subject to this precaution, it will be possible to extend the application of 
COLEGRAM in to a number of cases, for example to beta or electron spectrometry or 
wavelength-dispersive X-ray spectroscopy. 
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APPENDIX 1 - Approximation procedure with the Marquardt-
Levenberg algorithm [3] 

 
 
 

The fitting procedure using the Marquardt-Levenberg algorithm combines two methods, using 
respectively the Hessian and the gradient of the function to be fitted.  

 
 

 A1.1 Hessian method  
 

The fitting procedure proceeds in the following steps: close to the minimum, function Φ can 
be developed as per the Taylor series: 

 

k
k,j

j
kj

2
j

j j
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a
)a;x()aa;x( δδ
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Φ∂
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∂
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If we set: C = Φ(x; a0)  B = - ∇Φ x; a0  [ ]
kj

2

k,j aa
H

∂∂
Φ∂

= x; a0 

 
The development can be written in matrix form:  

 

Φ(x; a0+ δa) ≈ C - B . δa + 1
2

 δa . H . δa               [A2] 

 
The gradient of this expression is:  

 
∇Φ x; a0+δa ≈ H . δa - B              [A3] 

 
Minimum value of Φ is obtained for values of the parameters amin. 

 
At amin = a0 + δa, ∇Φ x; amin = 0. Thus, we get: 

 
 

amin = a0 + H-1 . [ - ∇Φ (x; a0) ]             [A4] 
 

This first process constitutes the so-called “Hessian” method. 
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 A1.2 Gradient method 
 

The Hessian method works when the Taylor series approximation is close enough to the 
function: this is the case near the minimum. Far from it, as the bias is wider, this method is 
less efficient. Thus, to come close to the minimum, the gradient method is used.  

 
The parameters values are obtained by successive iterations according to the expression: 

 
a’ = a - λ . [ - ∇Φ (x; a) ]          [A5] 

 
The λ constant must be small enough so that the procedure actually converges to a best fitting 
point.  

 
 

 A1.3 Computation of the Hessian 
 

Both methods require computation of the components of the gradient of Φ: 
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The complete Hessian determination requires computation of partial derivatives of the second 
order: 
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For a correct model, term [yi - f(xi; a)] represents the random bias of each experimental point: 
it tends towards zero when summing over the i's and thus can be disregarded. This remark 
entitles simplifying the above expression: 
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Thus, whatever the used method may be, only computation of first derivatives is required. 

 
 

A1.4 Marquardt-Levenberg algorithm 
 

In this process, the gradient method is used far from the minimum; it is then progressively 
replaced by the Hessian method. 

 
From [A5], the gradient method can be written: 
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jj

j
j H

b
a

λ
=δ          [A9] 

 
and the Hessian method is: 

kj
n

1j
kj ba'H =δ⋅∑

=
        [A10] 

 
A new matrix, H', is defined by integrating both methods:  

 
H'jj = Hjj (1 + λ) 
 
H'kj = Hkj              (k ≠ j) 
 

δaj is then obtained when solving: 
 

kj
n

1j
kj ba'H =δ⋅∑

=
      [A11] 

 
When λ is large, H' diagonal terms are dominant and we are close to the gradient method; 
when λ decreases, the Hessian method is predominant. 

 
In practical, the fitting procedure proceeds according to the following steps:  

 
1. Definition of initial values for a0; 
 
2. Computation of Φ(a0); 
 
3. Choice of a value for λ (here, 10-2); 
 
4. Resolution of the equation for δa and evaluation of Φ(a0+ δa); 
 
5. If Φ(a0+ δa) > Φ(a0): λ ←  λ x 10 and back to step 4; 
 
6. If Φ(a0+ δa) < Φ(a0):  λ ←  λ / 10; a0 = a0+ δa and back to step 4. 
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APPENDIX 2 - Background subtraction in gamma-ray spectrometry 
 

 
 
Two methods are mainly used to deal with spectrum background: modeling or subtraction. In 
the first case, the background shape is modeled using a simple function, polynomial or 
exponential, that is added to the functions used to fit the peaks. This induces supplementary 
parameters to be taken into account in the fitting procedure.  
 
In the case of gamma-ray spectrometry, the background does not often provide any 
quantitative information useful in the spectrum processing. Thus, the second method has been 
implemented in COLEGRAM: it consists in subtracting the background from a (limited) 
region of interest of the raw spectrum.  
 
Several models can be used to compute such a background: the simplest method fit a linear 
function to limiting channels of the ROI. More sophisticated models take into account the 
physical peak presence by an integration over the ROI channels [12,13]: this processing 
allows to include the discontinuity corresponding to the maximum energy of the full-
absorption peak. 
 
This technique is used in COLEGRAM, computing the background corresponding to channel 
i as:  

[ ]Fk i Y m Y n Y m S i
S n
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k is the iteration number, m and n are the ROI start and end channels, respectively. 
 
Several tests were conducted while repeating this processing and examining the iteration 
influence over the background shape. This study has shown that processing convergence is 
obtained after two iterations. 

 



 

 
28

A
PP

E
N

D
IX

 3
 - 

L
is

t o
f p

ar
am

et
er

s i
n 

th
e 

re
su

lts
 fi

le
s 

  Th
e 

fo
llo

w
in

g 
ta

bl
es

 p
re

se
nt

 f
or

 e
ac

h 
fu

nc
tio

n 
th

e 
pa

ra
m

et
er

s 
an

d 
th

e 
w

ay
 o

f 
co

m
pu

tin
g 

th
e 

pe
ak

 a
re

a 
(S

ur
fa

ce
 x

 c
al

ib
) 

ac
co

rd
in

g 
to

 th
e 

or
de

r t
he

y 
ar

e 
qu

ot
ed

 in
 th

e 
re

su
lts

 fi
le

s. 
“c

al
ib

” 
is

 th
e 

ca
lib

ra
tio

n 
fa

ct
or

 (e
ne

rg
y/

ch
an

ne
l) 

 In
 th

e 
re

su
lts

 fi
le

s, 
th

e 
pa

ra
m

et
er

s a
re

 n
am

ed
 a

s f
ol

lo
w

s:
  

“P
ar

am
 1

 =
 “

En
er

gy
”,

 P
ar

am
 2

 =
 “

A
m

pl
itu

de
”,

 P
ar

am
 3

 =
 “

Si
gm

a”
, P

ar
am

 4
 =

 G
am

m
a”

 
H

ow
ev

er
, t

he
se

 la
be

ls
 a

re
 v

al
id

 fo
r t

he
 fi

rs
t t

w
o 

fu
nc

tio
ns

, f
or

 th
e 

fo
llo

w
in

g 
on

es
, t

he
re

 a
re

 n
o 

sp
ec

ifi
c 

la
be

ls
.  

 Ta
bl

e 
I-

a 
- B

as
ic

 p
ea

k 
sh

ap
es

 
 

Fu
nc

tio
n 

G
au

ss
  

V
oi

gt
  

T
ai

le
d 

G
au

ss
 

G
au

ss
 w

ith
 tw

o 
ta

ils
  

Pa
ra

m
1 

Po
si

tio
n 

Po
si

tio
n 

Po
si

tio
n 

Po
si

tio
n 

Pa
ra

m
 2

 
A

m
pl

itu
de

 (A
) 

A
m

pl
itu

de
 (A

) 
A

m
pl

itu
de

 (A
) 

A
m

pl
itu

de
 (A

) 
Pa

ra
m

 3
 

St
an

da
rd

 d
ev

ia
tio

n 
(σ

) 
St

an
da

rd
 d

ev
ia

tio
n 

(σ
) 

St
an

da
rd

 d
ev

ia
tio

n 
(σ

) 
St

an
da

rd
 d

ev
ia

tio
n 

(σ
) 

Pa
ra

m
 4

 
 

Lo
re

nt
z 

w
id

th
 (Γ

) 
Ta

il 
re

la
tiv

e 
am

pl
itu

de
 (T

A
) 

Le
ft-

ha
nd

 ta
il 

re
la

tiv
e 

am
pl

itu
de

 (T
A

1)
 

Su
rf

ac
e 

 
x 

ca
lib

 
A

σ
π2

 
A

σ
π2

 
(

) τ
+

σ
π

TA
A

2
 

(
)

2
2

1
1

2
τ

−
τ

+
σ

π
TA

TA
A

 

Pa
ra

m
 5

 
- 

- 
Ta

il 
sl

op
e 

(τ
) 

Le
ft 

ta
il 

sl
op

e 
(τ

1)
 

Pa
ra

m
 6

 
 

 
 

R
ig

ht
-h

an
d 

ta
il 

re
la

tiv
e 

am
pl

itu
de

 (T
A

2)
Pa

ra
m

 7
 

 
 

 
R

ig
ht

-h
an

d 
ta

il 
sl

op
e 

(τ
2)

 

 



 

 
29

 

 

Table I-b - B
asic peak shapes 
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  Table III - F
unctions conditional upon standard deviation 

   
Function

G
auss (sigm

a) 
V

oigt (sigm
a) 

A
lpha (sigm

a) 
Param

1 
Position 

Position 
Position 

Param
 2 

A
m

plitude (A
) 

A
m

plitude (A
) 

A
m

plitude (A
) 

Param
 3 

Standard deviation offset(σ
0 )

Standard deviation offset (σ
0 ) 

Standard deviation (σ) 
Param

 4 
Standard deviation slope (k)

Lorentzian w
idth (Γ) 

First tail relative am
plitude (TA

1 ) 
Surface 
x calib 

A
kx

⋅
+

σ
⋅

π
20

2
 

A
kx

⋅
+

σ
⋅

π
20

2
 

(
)2

2
1

1
2

τ
+

τ
+

σ
π

TA
TA

A
 

Param
 5 

- 
Standard deviation slope (k) 

First tail slope (τ
1 ) 

Param
 6 

- 
- 

Second tail relative am
plitude (TA

1 )
Param

 7 
- 

- 
Second tail slope (τ

1 ) 
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 Table V
 - M

ore specific functions 
  

Function 
H

yperm
et 

H
yperm

et V
oigt 

L
ow

 energy X
 G

auss 
L

ow
 energy X

 V
oigt 

Param
1 

Position (E) 
Position (E) 

Position (E) 
Position (E) 

Param
 2 

A
m

plitude (A
) 

A
m

plitude (A
) 

A
m

plitude (A
) 

A
m

plitude (A
) 

Param
 3 

Standard deviation (σ) 
Standard deviation (σ) 

Standard deviation (σ) 
Standard deviation (σ) 

Param
 4 

Tail relative am
plitude 

(TA
) 

Lorentzian w
idth (Γ) 

Tail relative am
plitude (TA

) 
Lorentzian w

idth (Γ) 

Surface 
x calib 

(
)E
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A
⋅

+
τ

+
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π
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+
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+
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Param
 5 

Tail slope (τ) 
Tail relative am
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) 
Tail slope (τ) 

Tail relative am
plitude (TA

) 

Param
 6 

Step relative am
plitude 

(SA
) 

Tail slope (τ) 
Step relative am

plitude (SA
) 

Tail slope (τ) 

Param
 7 

- 
Step relative am

plitude 
(SA

) 
Truncated step relative am

plitude 
(STA

) 
Step relative am

plitude (SA
) 

Param
 8 

- 
- 

Truncation position (TE) 
Truncated step relative am

plitude 
(STA

) 
Param

 9 
 

 
 

Truncation position (TE) 
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APPENDIX 4 - Approximation of the Voigt function 
 
 
 

A4.1 General approximation 
 
The Voigt function can be written as the real part of the complex Voigt function, V(z): 
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V(z) can be approximated by a sum of four Lorentz functions [14]:  
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The real part is thus: 
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This approximation is used to compute the Voigt function and its derivatives required by the 
fitting procedure (see Appendix 1). This approach induces an easy computation, using simple 
arithmetical operations. In most cases, the accuracy is better than 10-4, what is satisfactory when 
using this function in the fitting procedure.  
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A4.2 “Voigt plus” approximation 
 
However, in some cases, if the ratio Γ/σ becomes lower than about 0.1, the previous 
approximation fails to represent the Voigt shape. It is then possible to use W. Gautschi’s 
algorithm [15]. 
 

 
 


